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TO CREATE A NEW FILE 
1. From Google Drive, locate and select the New button, 

then choose the type of file you want to create. In our 
example, we'll select Google Docs to create a 
new document. 

 
2. Your new file will appear in a new tab on your browser. 

Locate and select Untitled document in the upper-left 
corner. 
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3. The Rename dialog box will appear. Type a name for 

your file, then click OK. 

 
4. Your file will be renamed. You can access the file at any 

time from your Google Drive, where it will 
be saved automatically. Simply double-click to open the 
file again. 
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You may notice that there is no Save button for your files. This is because 
Google Drive uses autosave, which automatically and immediately saves 
your files as you edit them. 
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USING TEMPLATES 

A template is a pre-designed file you can use to quickly create new 
documents. Templates often include custom formatting and designs, so 
they can save you a lot of time and effort when starting a new project. Most 
templates are designed to help you create specific types of files. For instance, 
you could use a template to quickly create a resume or newsletter. 

 
 
You can find a wide selection of templates in the Google Drive Template 
Gallery. 
  

https://drive.google.com/templates
https://drive.google.com/templates
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To use an official Google template: 
1. Navigate to the template gallery. 
 

 
 

2. When you've found a template you want to use, 
click the template to select it. 

https://docs.google.com/document/u/0/?ftv=1&tgif=c
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3. A new file will be created with the selected template. You 
can then customize the file with your own information. 

 

  



7 
 

THE GOOGLE DOCS INTERFACE 

The Google Docs interface includes the toolbar at the top of the screen, as 
well as the document itself. It allows you to type and modify text, in addition 
to sharing a document with others. 
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PAGE SETUP OPTIONS 

When you first create a Google document, you may want to change page 
setup options like page orientation, margins, or paper size, depending on 
the type of document you are creating. You can access these options by 
clicking Page setup in the File menu. 

In the Page setup dialog, you can customize several options: 
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• Page orientation is whether your page is oriented in 
portrait or landscape format. Landscape format means 
the page is oriented horizontally, while portrait format 
means it is oriented vertically. 

 
• Page margins are the gaps between the body of the 

document and the edge of the page. 
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• Paper size lets you change the dimensions of the page. 

This is particularly useful if you are printing the 
document on a custom paper size. 
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• Page color is the background color of the document. This 

may be useful as a decorative option if you plan on 
publishing your document on the Web. 



12 
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TO INSERT TEXT 
1. Locate the insertion point, which is a blinking vertical 

line. In a blank document, this will be near the top-left 
corner of the page. If the document already has text, you 
can click in different parts of the document to move the 
insertion point. 

2. When you begin typing, the text will appear next to the 
insertion point. 

 

TO SELECT TEXT 

Before you can move or format text, you'll need to select it. To do this, click 
and drag your mouse over the text, then release the mouse. A highlighted 
box will appear over the selected text. 

 

TO DELETE TEXT 

There are several ways to delete—or remove—text: 

• To delete text to the left of the insertion point, press 
the Backspace key on your keyboard. 

• To delete text to the right of the insertion point, press 
the Delete key on your keyboard. 

• Select the text you want to remove, then press 
the Delete key. 
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If you select text and start typing, the selected text will automatically be 
deleted and replaced with the new text. 
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COPYING, CUTTING, AND PASTING TEXT 

You may find that sometimes it's easier to copy and paste text that repeats 
often in your document. Other times, there may be text you want to move 
from one area of the document to another, in which case you'll need to cut 
and paste or drag and drop the text. 

The copy, cut, and paste commands are found in the Edit menu. Google Docs 
also uses keyboard shortcuts—or a combination of keys—to perform a 
variety of commands. We'll talk more about these shortcuts below. 
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To copy and paste text: 
1. Select the text you want to copy. 

 
2. Press Ctrl+C (Windows) or Command+C (Mac) on your 

keyboard to copy the text. 

3. Place your insertion point where you want the text to 
appear. 

 
4. Press Ctrl+V (Windows) or Command+V (Mac) on your 

keyboard to paste the text. The text will appear.  
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To cut and paste text: 
1. Select the text you want to copy. 

 
2. Press Ctrl+X (Windows) or Command+X (Mac) on your 

keyboard to cut the text. 

3. Place your insertion point where you want the text to 
appear. 

 
4. Press Ctrl+V (Windows) or Command+V (Mac) on your 

keyboard to paste the text. The text will appear. 
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To drag and drop text: 
1. Select the text you want to move to another place in the 

document. 

 
2. Click and drag the text to the location where you want it 

to appear. The cursor will have an insertion point under 
it to indicate you're moving text. 

 
3. Release the mouse button, and the text will move to the 

new location. 
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TO INSERT SPECIAL CHARACTERS 

Google Docs offers a large collection of special characters. They are useful 
when writing equations, and they can serve as decorative accents as well. 

1. Place the insertion point where you want to insert a 
special character. 

2. Click Insert, then select Special characters. 

 
3. The Insert Special Characters dialog box will appear. 
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4. Use the drop-down arrows above the character grid 

to browse groups of symbols. In our example, we are 
browsing for musical symbols to add to our document. 
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5. Click the desired symbol to insert it into your document. 
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6. The symbol will appear in your document. 
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SPELL CHECK AND SUGGESTED SPELLING 

By default, Google Docs will automatically check for misspelled words and 
make suggested spellings. Words with spelling suggestions are underlined 
in red. 

 

To use suggested spelling: 
1. Right-click an underlined word. A drop-down menu 

with suggested spellings for the misspelled word will 
appear. Select the correct spelling from the list. 

 
2. The correct spelling will appear in place of the misspelled 

word in the document. 
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Occasionally, Google Docs will suggest spellings for a word it does not 
recognize, like the name of a person or a company. If you are certain of the 
spelling, you can add the word to the dictionary. Once you add a word to the 
dictionary, Google Docs will keep the spelling of the word. 
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USING FIND AND REPLACE 

When you're working with longer documents, it can be difficult and time-
consuming to locate a specific word or phrase within the document. Google 
Docs can automatically search your document using the find feature, and it 
even allows you to change words or phrases using the replace feature. 

To find text: 
1. Click Edit, then select Find and replace. 

 
2. The Find and replace dialog box will appear. 

3. Type the text you want to find in the Find field. 
The number of times the word appears in the text will 
appear in the Find field, and each appearance will 
be highlighted throughout the document. 
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4. If the word appears more than once, you can click 

the Prev and Next arrows to jump to the next 
appearance. When the word is selected, the highlight will 
darken and pulsate briefly. 
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5. Click X to close the dialog box. 
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To replace text: 
1. Click Edit, then select Find and replace. The Find and 

replace dialog box will appear. 

2. Type the text you want to find in the Find field. Type the 
text you want to replace it with in the Replace with field. 

3. Click Next or Prev and then Replace to replace text. If 
you want to replace all occurrences of the text within the 
document, click Replace all. 
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THE TOOLBAR SHORTCUT MENU 

Google Docs offers a variety of text formatting options you can use to modify 
the look and feel of your document. These options are located in 
the Toolbar Shortcut menu. In the following lesson, you'll learn how these 
options can help enhance your document's appearance. 

 

To change the font: 
1. Select the text you want to modify. 

 
2. Click the Font drop-down arrow on the toolbar. A font 

menu appears. The name of each font has been formatted 
to look like the style it describes. 
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3. Select the font you want to use. In our example, we'll 

hover over Roboto and select Normal font. 

 
4. The selected text will change to the new font. 
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If you don't see the font you're looking for—or if you would like more fonts to 
choose from—Google Docs allows you to add additional fonts to the Font 
drop-down menu. Click More fonts from the Font drop-down menu to open 
the Fonts dialog box. 
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To change font size: 
1. Select the text you want to modify. 

 
2. Click the Font size box from the toolbar. A drop-down 

menu of font sizes appears. 

 
3. Select the font size you want to use. In our example, we'll 

change the font size to 24 to make it larger. 
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4. The text will change to the new font size. 
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TO CHANGE TEXT COLOR: 
1. Select the text you want to modify. 

 
2. Click the Text color command from the toolbar. A drop-

down menu of text colors appears. 

 
3. Select the circle of the text color you want to use. In our 

example, we'll choose blue. 
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4. The text will change to the new color. 
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To use the bold, italic, and underline buttons: 
1. Select the text you want to modify. 

2. Click the bold (B), italic (I), or underline (U) button from 
the shortcut toolbar. 
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TO CHANGE TEXT ALIGNMENT 

There are four alignment buttons in Google Docs that you can choose from 
the Align drop-down menu.  

 
• Left align: Aligns all selected text to the left margin 

• Center align: Aligns text an equal distance from the left 
and right margins 

• Right align: Aligns all selected text to the right margin 

• Justify: Text is equal on both sides and lines up equally to 
the right and left margins; many newspapers and 
magazines use full justification 

1. Select the text you want to align. 

 
2. Click the desired alignment button. 
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3. The text will realign. 

 

  



41 
 

LINE AND PARAGRAPH SPACING 

In Google Docs, line spacing is measured in lines. For example, when text 
is double spaced, the line spacing is two lines high. You can reduce the line 
spacing to fit more lines on the page, or you can increase it to improve 
readability. 

To format line spacing: 
1. Select the text you want to format. 

 
2. Click the Line spacing button, then select the 

desired line spacing option from the drop-down menu. 
You can also click Custom spacing to fine-tune the 
spacing. 
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3. The line spacing will adjust in the document. 
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Paragraph spacing 

Just as you can format spacing between lines in your document, you can 
choose spacing options between each paragraph. Typically, extra spaces are 
added between paragraphs, headings, or subheadings. Extra spacing 
between paragraphs is another way to help to make a document easier to 
read. 

To format paragraph spacing: 
1. Select the text you want to format. 

 
2. Click the Line spacing button. 

3. Select Add space before paragraph or Add space after 
paragraph from the drop-down menu. You can also 
click Custom spacing to fine-tune the spacing. 
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4. The paragraph spacing will adjust in the document. 

 

To remove paragraph spacing, click the line spacing button, then 
select Remove space before paragraph or Remove space after paragraph. 



45 
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HYPERLINKS 

A hyperlink is a link to a web address (or URL). If you want to include a web 
address in your Google document, you can format it as a hyperlink for 
someone to click. The hyperlink will then open the webpage in a new browser 
window. 

To insert a hyperlink: 
Hyperlinks have two basic parts: the address (URL) of the webpage and 
the display text. For example, the address could 
be http://www.apple.com/ipad and the display text could be Apple iPad. 
When you're creating a hyperlink in Google Docs, you'll be able to choose 
both the address and the display text. 

1. Select the text you want to make a hyperlink. 

 
2. Click the Insert link button, or right-click the selected 

text and click Link. 

 

3. The Edit Link dialog box will appear. In the Text field, 
the selected text will appear. You can modify this text if 
you want. 

4. Type the address you want to link to in the Link field. 
Google Docs may automatically fill in this field if the text 
you've selected looks like a URL. 

http://www.apple.com/ipad
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5. Click Apply. The text you selected will now be a 

hyperlink. 

 
6. Click the link to view the URL. 

 

If you want to change or remove the hyperlink, click the link and 
select Change or Remove from the options that appear below the hyperlink. 
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INDENTING TEXT 

In many types of documents, you may want to indent only the first line of 
each paragraph. This helps to visually separate paragraphs from one 
another. 

 

To indent using the Tab key: 

A quick and common way to indent is to use the Tab key. This will create a 
first-line indent of a half-inch. 

1. Place the insertion point at the very beginning of the 
paragraph you want to indent. 
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2. Press the Tab key on the keyboard. The text in the first 

line will move to the right by a half-inch. 

 

To indent using the Indent shortcut buttons: 

If you want to indent all lines in a paragraph, you can use the Increase 
indent and Decrease indent shortcut buttons. 
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1. Select the text you want to indent. 

 
2. Click the Increase indent shortcut button 

to increase the indent by increments of a half-inch. 

 
3. All lines of the paragraph will indent. 

 
4. Click the Decrease indent shortcut button 

to decrease the indent by increments of a half-inch. 
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You can also click Format from the toolbar. Then, hover over Align & 
indent to locate the Increase indent and Decrease indent commands. 
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CUSTOMIZING INDENTS 

You can use the three indent markers and the Ruler to create custom 
indents that are larger or smaller than the Tab key's default half-inch indent. 
When you move the indent markers, the Ruler provides a blue guide line to 
help you see where the indent will appear. 

 
• First Line Indent marker: Adjusts the first-line indent of 

a paragraph 

 
• Left Indent marker: Moves in unison with the First Line 

Indent marker to indent all lines in the paragraph 
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• Right Indent marker: Increases or decreases the right 
indent by moving all lines of the paragraph from the right 
margin 
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To customize indents with the Ruler: 
1. Place the insertion point anywhere in the text or 

paragraph you want to indent (you can select one or 
more paragraphs). 

2.  
3. Click and drag the desired indent marker. As the marker 

moves, the blue guide line extends from the Ruler. 
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4. Release the mouse at the desired location. The text will 

indent. 

 

To indent the paragraph on the right side, click and drag the Right 
Indent marker. 
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HEADERS AND FOOTERS 

The header is a section of the document that appears in the top margin, 
while the footer is a section of the document that appears in the bottom 
margin. Text entered in the header or footer will appear on each page of the 
document. 

 

To insert a header or footer: 
1. Click Insert, then hover over Headers & footers. From 

the drop-down menu, you can select 
either Header or Footer. 
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2. Depending on your selection, the insertion point will 

relocate to either the top or bottom margin of the page. 
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3. Type the desired text. When you're finished, press 

the Esc key on your keyboard to close the header or 
footer. 
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After you close the header or footer, it will still be visible, but it will be locked. 
To edit it again, just click anywhere on the header or footer, and it will 
become unlocked. 
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Formatting text in a header or footer 
To format text in headers and footers, you can use many of the same 
formatting options that are available to format text in the body of your 
document. You can align the text, modify the font style and size, and 
add bolding, italics, and underlining. Visit our lesson on Formatting Text 
and Adding Hyperlinks to learn more about the formatting options 
available in Google Docs. 

 

To add page numbers to a header or footer: 

Google Docs can automatically label each page with a page number and 
place it in a header or footer. If you want to display the word Page as part of 
the page number, you will need to type Page at the desired location in the 
header. 

1. Select the document's header or footer. 

2. Place the insertion point where you want the page 
number to appear. Type the word Page if you want. 

https://edu.gcfglobal.org/en/googledocuments/formatting-text-and-adding-hyperlinks/1/
https://edu.gcfglobal.org/en/googledocuments/formatting-text-and-adding-hyperlinks/1/
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3. Click Insert and hover the mouse over Page numbers, 

then select Top of page or Bottom of page. 
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4. The page number will appear. 
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To display the page count: 

Google Docs can also automatically display the page count—or how many 
pages your document has—in the header or footer. If you want to add the 
page count next to the page number, you will need to type the word "of" after 
the page number. 

1. Place the insertion point after the page number, then 
type of. 
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2. Click Insert, then hover over Page numbers. From the 

drop-down menu, select Page count. 
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3. The page count will appear in the document after the 

page number. 
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PAGE BREAKS 

Page breaks allow you to have more control over the layout of your 
document. You might use a page break if you're writing a paper that has 
a title page or a bibliography to ensure it starts on a new page. 

To insert a page break: 
1. Place the insertion point at the location where you want 

the page break to appear. 

 
2. Click Insert, then hover over Break. From the drop-

down menu, select Page break. 
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3. The page break will appear in the document. 
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To remove a page break, place the insertion point below the break and press 
the Backspace key on your keyboard. You may need to press the key several 
times to delete the break. 

  



71 
 

DOWNLOADING AND PRINTING FILES FROM GOOGLE DRIVE 

Once you've created a file, it will be accessible whenever you sign in to 
Google Drive. However, there may be times when you want 
to download or print a file for offline access. 

To download a file: 
1. Locate and right-click the file you want to download, then 

select Download. 

 
2. The file will be downloaded to your computer. 
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To choose a file format: 

By default, Google Drive will choose the most common file format whenever 
you download a file. For example, if you download a Google Document, it will 
automatically be saved as a .docx file, which is used by Microsoft Word and 
most other word processors. However, there may be times when you want to 
choose a different format, such as PDF. 

1. Double-click the desired file to open it. 

 
2. The file will appear in a new tab. Select File > Download 

as, then choose the desired file type. In this example, 
we'll choose PDF Document (.pdf). 
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3. The file will be downloaded to your computer in the 

desired file type. 
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To print a file: 
1. Double-click the desired file to open it. 

2. Select File > Print. 

 
3. The Print dialog box will appear, along with a preview of 

your file on the right. Choose the desired options, then 
click Print. 
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Note that these options will vary depending on the type of file you're printing. 
For example, you'll have different options for printing a spreadsheet than you 
would for printing a presentation. 
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